Using the Data Extract Feature in
BannerINB

Data can be extracted from many of the Banner Finance forms and imported into
Excel or Access for analysis. Currently the following forms are activated for extract:
FGIBDST( Budget Status), FGITRND (Transaction Detail), FRIGITD (Grant Inception
to Date), FRIGTRD (Grant Transaction Detail) and FGIBDSR (Executive Summary).
Additional forms will be added in the future.

1. In BannerINB open any of the above mentioned forms.

2. Enter the appropriated information in the key block and perform a next-block.

3. From the menu at the top of the page, choose Help.

& Oracle Developer Forms Runtime - Web: Open, > FGIBDST
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[ Query Specific Account Ac Display ID Image
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Ac Calculator
Commit Type: o .
Ewtract Data with Key
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4. In the Help menu, choose either of the Extract Data options. ‘Extract Data with
Key’ includes the information you entered in the key block. Extract Data No Key”
does not include this information.

5. One of several things may happen:

a. A quick flash and/or beep and the information on your screen does not
change. This is usually due to browser settings. See the troubleshooting
section at the end of this document for help with these settings

b. A new window opens, but it's blank — press the F8 key on your keyboard
to pull in the data
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c. A new window opens with the data showing with quotation marks and
commas.
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Contains commands For working with the selected items.

i. From the File menu choose ‘File’ (Arrow 1) ‘Save As..." (Arrow 2)
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ii. Select the location to store the file
iii. Change the File Name so that it is meaningful to you.
iv. Change the File Type to Text

v. Click Save
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B3 Microsoft Excel - Book1
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vi. Open Excel

vii. From the menu choose File From the file menu choose Open
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viii. Change the document path to the location where you stored your
file

ix. Change the file type to Text

X. Locate and open your file
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% Text Import Wizard - Step 1 of 3

B The Text Wizard has determined that your data is Fixed Width,

7 IF this is correct, choose Mext, or choose the data type that best describes your data,

g Original data type
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10 1 (O] - Characters such as commas or kabs separate each field.

11 / (9] width - Fields are aligned in columns with spaces between each field,
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13 Start import at row: Fieorigin: | 437 : OEM United States v

14
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25

26

27 2

28

29 b
30
_31 — 1 —— 1 1 1 !
W 4+ H)\Sheetl f Sheet? / Sheets / I | ¥
Ready MM

xi. A wizard will start asking how you would like to import your data
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T4 Using the Data Extract Feature in BannerINB. doc - Microsoft Word

Type a question for help = %

—1
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i haow wour text is affected in the preview below,
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= Fromthe menu choose File 2
= Fromthe file menu choose Save As o
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2. Select comma (Arrow 1) and click finish (Arrow 2)

xii. Your file will open as a spreadsheet.

d. A new window opens with your data displayed as an Excel spreadsheet.
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B3 Microsoft Excel - FGIBDST. txt E]E]@

@_]E‘ Edit Wiew Insert Formak  Jools  Data  FlashPaper  window Help  Adobe POF Type s question for help = _ @ X
i 3| open.. { 0 @ F LA 2] 4 100 ,@!
P | Sweds. $ % s w0 = oo AR
Page Setup,.. [r—
Print... ' Crl+P
| 1 FGIBDST bt [ D [ E G T ] I
;: 2 Bo|SarsiRecontiistionsion. . \tbIONCrdSummary. s .Query Specific Account .I\:clude Revenue Accounts [Commit Type JOrganization T EE;ME(FH lFqumm
[ 3| 3 Pi\5ardiUploads\CFCDS-31-07. pm Adjusted Budget YD Activity Commitrments | Available Balance
| 4 | 4 Pt\Sara) TemplatesiBudget Load.XLS 0 50 0 -50
15 | ¥ 0 48 0 -48
| 6 | T COpyT e 1] B591.59 0 -6591.5
7| B1000L Faculty Salaries | 2028920 1989251.558 0 39738.42
8| ®B100L Other Faculty-10% Benefits 6750 6851 0 -1
| 9| B1800L Student Payrall 1} 1111.85 0 -1111.88
| 10 | 2100 L Benefits 634622 B17353.03 0 17268.97
| 17 | 70935 T Exp TFS-Misc o 657 0 Ba7
|12 | 7102 E Lecturer-Dept 1] B15.19 0 -615.19
13| T1EME Suppl-Office 0 1830.97 0 -1830.97
14| 71801 E SupphInstructional a0 0 0 a0
| 16 | 71702 E Suppl-Computer | 1] 0 0 0
16| 72001 E Central Services Copying 5500 9791 .46 0 -4291 46
| 17 | TZINE Film Rental 100 9289 0 7.1
18| 74001 E Travel-Domestic | 0 34 0 -35
19| 74501 |E Entertain-General 284 sz 0 -385
20| T4E12E FSIA (Faculty-Student Activities) 700 73731 0 373
121 | 74515 E Entertainment-Faculty 350 350 0 0
| 22 | T4B57 E Mailing-Courier (FedEx, UPS, etc) 300 81.05 0 218.95
(5] 74115 E Snacks | a 19.04 0 -18.04
24| TTMME Memberships 425 825 0 i]
25| TM4BBE Catering 1} 44 0 -44
26| TI7TTE Miscellaneous | 397 -70.71 0 46771
| 27 | 85211 E Equip-Prior Year 1] 0 235 -235
3|
=l
|30
Edl _ _ _ 3
W 4 v ¥\FGIBDST / i i |« | s

Ready Sum=235 UM

6. Be sure to save your file in Excel format
i. From the top menu choose File

ii. From the File menu choose Save As
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Save in; |D My Documents i #'( [y 5 = Tools -
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: g My Documents || B 1 n42R eport. xls 241KB  Microsoft Excel h

-I ; Ezeq2-61402. s 9KB Microsoft Excel
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iii. Choose the location to store your file

iv. Change the file name to something meaningful to you.

v. Make sure the file type is Excel spreadsheet.

vi. Click Save

3

Your data is now in a spreadsheet that can be sorted, searched, totaled, subtotaled and
anything else you can do with an Excel spreadsheet.
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Trouble Shooting the Pop-up blocker
The file that needs to be opened is considered a pop-up by most browsers. If you
start to extract your data and nothing appears to be happening, you need to set your
browser to allow the pop-ups from Banner to open:

If you are using Internet Explorer

EP:'J Usmg the Data Extract Feature in BannerINB.doc - Microsoft Word

Acrobat Comments

Internet
Internet Explorer

.
B Notepad

Secure File Transfer
9 Client

@ Groupiise

E-mail
Grouptiise

D

Irfan¥iew - Thumbnails
Pinball

Minesweeper

@
w

7

Adobe Acrobat 7.0
Professional

All Programs D

pu |
i : ! : | Al
£ Daoubiechck the Internet Cptions icon |
d Cick o the Security tat
. Chck on Trusted Sites
I ChckonSites
g Enter bips [° smuth edy and chck ihe add button
B In e Secunty level area, sat the leval 1o Medium.low
2. you are using Firsfox,
@ Minimizs the Banner
2 b Maarmize the Mrﬂcﬂrlm nesds to stay open in the background for @
’_} My Documents Banned 10 run .
c ﬂllmlmo‘lﬂonm ou will 5 an 8k Message Siating the .
Firefox has blocked you from apening the fik .
B My Recent Documents F
ﬁ My Pictures
;, My Music
; art
@ My Computer Cane|
g MU NEEUO R Places lickthe m_temet Options icon
| the Security tab
@P Contral Pane! \ Sites
Macromedia Dreamweayer 8 Set Program Accesg Da smith.edu and click the add button
Defaults = < 7
= curity level area, set the level to medium-low.
Q Printers and Faxes Firefox
: - the Banner window,
) telp and Support e the window that needs to stay open in the background for al
) orun
Search
p of the page, you will see an alert message stating the
=7 Run... as blocked you from opening the file ™|
options button at the right of the alert message =
ways allow pop-ups from banner smith.edu *
¥

2 smith. ., B3 micra... M0 00C

O Lsing. .

a. Go to Start -> Control Panel
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ay  Favarites  Tools  Help

'\_.;J l? @) Search H_ Falders v

IR RN

..............................

iccessibility; Add Hardware add ar Adrinistrative Adobe

Category View [ § Options | Remoy. .. Tools
T @9 & s
e

zame Inke!” Inkernet lava Kyl

Controllers Ex //Optu:uns
i} @7 4% AN ¢

lpdate

auppark

b. Double-click the Internet Options icon

ener. ' SEcurity |F‘ri\.fa|:§.f I Content I Connections I Prograrms I fdvanced I

1|
Aﬁﬁa zone ko wiew or change security settings,
@ €« v O

Inkernet Local intram=  Trusted sites Restricked

2 / sites
Trusted sik,e/ it |
ites
V/ This zone contains websites that yon =
krust nok ko damage wour compr 3 /

wour Files.
¥ou have websites in this 2one,

"Security level For this zone ‘

—

c. Click on security tab (Arrow 1) and select Trusted Sites (Arrow 2). Click “Sites”
button (Arrow 3).
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€ Control Panel

LS
i Fle Edt View Favorites Tools  Help aﬂ'

Qﬁa;k Q l& pSearch H; Folders -

¢ Address |G’ Cantrol Panel v| g
D P R @ g
- o @
ve Adobe Gamma  Automatic  Date and Time Display Falder Options Fants
Updates
i
B Y @ ¢
\ =

Mail Microsoft Mail Mouse Metwork  MNetwork Setup

Add this Web site to the zone: 1 2 Postoffice Connections Wizard

[ | Add R A @
rTa e 9 © 9

Internet Properties

-
s Control —a—;

Trusted sites |? Hxl
-

ou can add and remaove Web sites From Ehis zone, Al web sites
in this zone will use the zone's security “gs, k-

See Also

Wieh sites: d QuickTime  Regional and  Scanners and  Scheduled Security Sounds and
https:i*, smith, edu Remove Language ... Cameras Tasks Cenker Audio Devices
ﬁ ) @ &
[ ‘.'\-! 1 1
ts Windows Wireless Jlriitiator Jlriitiator

Firewall  Metwork Set...  1.3.1.22 1.3.1.18
[ Require server verification (https:) For all sites in this zone

/

/Lﬂ!"ﬂf{evel J[ Default Level }

d. Enter https://*.smith.edu in the text entry box (Arrow 1) and click the ‘Add’

button (Arrow 2). Click “OK” button (Arrow 3) to save and exit this
window.
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nternet Properties [?]
General | Security | Privacy | Content | Connections | Programs | Advanced
Select a'web content zone to specify itz secunty settings.
2 0 @
Intermet Localintranet  Trusted sites Restricted
site

Trusted sites

Thiz zone contains ‘web sites that you
truzt hot to damage your computer or
data.

Security level for thiz zone
Move the lider to get the security level for this zone.
Medium-low
- Same az Medium without prompts
- Mozt content will be run without prompts
- Ungigned Activel contralz will not be downloaded
/ [ | - Appropriate for sites on your local network intranet)

1
g

-

’ Custom Level... ] ’ Default Level ]

2
_—

2

’ 0K H Cancel ]

If you are using Internet Explorer 6, set the level to medium-low (Arrow 1).
Click “OK” button to save and exit. If you are using Internet Explorer 7 or

8, click on the “Custom level...” button (Arrow 2).
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Security Settings - Trusted Sites Zone El

— Setkings

{) Disable ;I
¥} Enable
) Prompt
|| Scripk Activel controls marked safe For scripting®
{) Disable
(&) Enable
) Prompt J
¥ Downloads
,93 Aukamatic prompting For file downloads
() Disable :
® e
,gﬁ File download
) Disable
{¥) Enable

,frﬁ Fant download

™ Nizahls x
1| | b

*Takes effect after wou restart Internet Explorer

—Resek cuskorn settings

Reset to: IMedium {default) j Reset... |
8] 4 I Cancel |

f. Locate the ‘Downloads’ section. Change “Automatic prompting for file
downloads” setting from Disable to Enable. Click “OK” to save and exit.
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If you are using Firefox,

) Mozilla Firefox

File Edit ‘Wiew Go Boolmarks BEWES Help

<§| . I_: } [@ _1 - ﬂ Web Search ChrlHK

; / Read Mail {0 new)
|| Tara || Smith Ceete Interne...

Mew Message...  Ctrl+M

Downloads Chrl+]
S Extensions

Themes

Javascript Console

Page Info

Clear Private Daba Ctr+Shift+Del
In
Cl  Qptions... 2
Akl

Internet Native

ANNET

PORTANT POLICY INFORMATION

paper records and electronic information systems is the p
1 only as nesded in the performance of job-related duties;

rrlnniin ar mandificabinn af nnmanal e confidantial infoems

g. Click Tools (Arrow 1) Options (Arrow 2).

ptions

x|

i & @ H & &

General  Pre Content

Downloads  Advanced

Load Images

[ for the originating web site only

Enable Java
Enable Javagcript

Fonts & Colors

1 W Lows
s 'arn me when web sites kry ta install extensi- 2 /

Allowed Sites
>

Defaul Fort: | Times Kew Roman

v‘ Size: |16 vl Advanced...

Colors.,..

(o] 4 ] [ Cancel ] [ Help I

h. Click on the ‘Content’ Tab (Arrow 1) and then on the ‘Allowed Sites’

button (Arrow 2).
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Fle Edit ¥ew Go EBookmarks Tools  Help

q.] - \'_J\> - @ 7 @’ |\;| https://banner, smith, edu:2999/

By @« G, |

[) Tara || Smith College Interne. .. | | GroupWise Webaccess

Information co

College. This in
should be safeg
authorization is
cases be referre
employees, but
of the college.

Handbook, the

All student recg
registrar's webs!
guidelines.

Please select "R
Remote Access

Internet Native

NANNNY

©) Allowed Sites - Popups

‘ou can specify which web sites are allowed to open popup windows, Type
the exact address of the site you want ta allow and then click Allow,

Address of web site:

perty of Smith

Allow

Site: Skatus
banner, smith, edu Allow

[Bemove Site ] [Rgmuva Al Sites ]

s confidentiality
lion without

es should in all
not only of its
ely high priority
e Student

> consult the
n and

sed to the

T A oo N A

il

|Elanner?Wmd0ws “F b H Submit ]

banner.smith.edu:9999 =

i. Inthe Allow Address box type: banner.smith.edu and click Allow

j.  Click Close to exit and save.

k. Click OK to exit and save.
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